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Chapter 234 

Non-Unity Null Tests for 
the Ratio of Two 
Proportions in a Cluster-
Randomized Design 
Introduction 
This module provides power analysis and sample size calculation for inequality tests of the ratio with a non-zero 
null hypothesis in two-sample, cluster-randomized designs in which the outcome is binary. 

Technical Details 
Our formulation comes from Donner and Klar (2000). Denote a binary observation by where g = 1 or 2 is the 
group, k = 1, 2, …,  is a cluster within group g, and m = 1, 2, …,  is an individual in cluster k of group g. The 
results that follow assume an equal number of individuals per cluster. When the number of subjects from cluster to 
cluster are about the same, the power and sample size values should be fairly accurate. In these cases, the average 
number of subjects per cluster can be used.  

The statistical hypothesis that is tested concerns the ratio of the two group proportions,  and . When 
necessary, we assume that group 1 is the treatment group and group 2 is the control group. With a simple 
modification, all of the large-sample sample size formulas that are listed in the module for testing superiority by a 
margin with two proportions using the ratio can be used here.  

When the individual subjects are randomly assigned to one of the two groups, the variance of the sample 
proportion is 

 

When the randomization is by clusters of subjects, the variance of the sample proportion is 

 

Ygkm

K g Mg

p1 p2

( )
σ S g

g g

g

p p
n,

2 1
=

−

( ) ( )( )

( )[ ]
σ

ρ

σ ρ

σρ

C g
g g g

g g

S g g

g S g

p p m

k m

m

F

,

,

, ,

2

2

2

1 1 1

1 1

=
− + −

= + −

=

http://www.ncss.com/


PASS Sample Size Software NCSS.com   
Non-Unity Null Tests for the Ratio of Two Proportions in a Cluster-Randomized Design 

234-2 
 © NCSS, LLC. All Rights Reserved. 

The factor  is called the inflation factor. The Greek letter  is used to represent the intracluster 

correlation coefficient (ICC). This correlation may be thought of as the simple correlation between any two subjects 
within the same cluster. If we stipulate that  is positive, it may also be interpreted as the proportion of total 
variability that is attributable to differences between clusters. This value is critical to the sample size calculation. 

The asymptotic formula for the Farrington and Manning Likelihood Score Test that was used in comparing two 
proportions (see Chapter 206, “Tests for the Ratio of Two Proportions with a Non-Unity Null Hypothesis”) may be 
used with cluster-randomized designs as well, as long as an adjustment is made for the inflation factor. 

Power Calculations 
A large sample approximation may be used that is most accurate when the values of n1  and n2  are large. The 
large approximation is made by replacing the values of p1  and p2  in the z statistic with the corresponding values 
of p1  and p2  under the alternative hypothesis, and then computing the results based on the normal distribution.  

Note that in this case, exact calculations are not possible. 

Procedure Options 
This section describes the options that are specific to this procedure. These are located on the Design and Options 
tabs. For more information about the options of other tabs, go to the Procedure Window chapter. 

Design Tab 
The Design tab contains the parameters associated with this test such as the proportions, sample sizes, alpha, and 
power.   

Solve For 

Solve For 
This option specifies the parameter to be solved for using the other parameters. The parameters that may be 
selected are Power, Sample Size (K1), Sample Size (M1), Effect Size, and ICC. Under most situations, you will 
select either Power or Sample Size (K1). 

Select Sample Size (K1) when you want to calculate the number of clusters per group needed to achieve a given 
power and alpha level. 

Select Power when you want to calculate the power of an experiment.  

Test 

Alternative Hypothesis 
Specify the direction of the alternative hypothesis. 

• One-Sided (H1: P1/P2 > R0) 
Refers to an upper-tailed, one-sided test in which the alternative hypothesis is of the type H1: P1/P2 > R0. 

• One-Sided (H1: P1/P2 < R0) 
Refers to a lower-tailed, one-sided test in which the alternative hypothesis is of the type H1: P1/P2 < R0. 
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• Two-Sided (H1: P1/P2 ≠ R0) 
Refers to a two-sided test in which the alternative hypothesis is of the type H1: P1/P2 ≠ R0. 

For one-sided tests, the direction you select must match the values entered for R0 and R1. For example, if you 
select H1: P1/P2 < R0, then the value(s) for R1 must be less than the value(s) for R0. 

Test Type 
The Likelihood Score (Farrington & Manning) Test is the only test available for this procedure. 

Power and Alpha 

Power 
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis, 
and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null 
hypothesis is not rejected.  

Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now, 
0.90 (Beta = 0.10) is also commonly used. 

A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.  

Alpha 
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true 
null hypothesis is rejected.  

Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means that 
about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents 
the risk of a type-I error you are willing to take in your experimental situation.  

You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01. 

Sample Size – Group 1 (Treatment) 

K1 (Clusters in Group 1) 
Enter a value (or range of values) for the number of clusters in group one. You may enter a range of values such 
as 10 to 20 by 2. The sample size for this group is equal to the number of clusters times the number of subjects per 
cluster. 

M1 (Items per Cluster in Group 1) 
This is the average number of items (subjects) per cluster in group one. This value must be a positive number that 
is at least 1. You can use a list of values such as 100 150 200. 

Sample Size – Group 2 (Reference) 

K2 (Clusters in Group 2) 
This is the number of clusters in group two. The sample size for this group is equal to the number of clusters times 
the number of subjects per cluster. This value must be a positive number.  

If you simply want a multiple of the value for group one, you would enter the multiple followed by K1, with no 
blanks. If you want to use K1 directly, you do not have to pre-multiply by 1. For example, all of the following are 
valid entries:10 K1 2K1 0.5K1. 

You can use a list of values such as 10 20 30 or K1 2K1 3K1. 
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M2 (Items per Cluster in Group 2) 
This is the number of items (subjects) per cluster in group two. This value must be a positive number.  

If you simply want a multiple of the value for group one, you would enter the multiple followed by M1, with no 
blanks. If you want to use M1 directly, you do not have to pre-multiply by 1. For example, all of the following are 
valid entries: 10 M1 2M1 0.5M1. 

You can use a list of values such as 10 20 30 or M1 2M1 3M1. 

Effect Size – Ratios 

R0 (Ratio|H0 = P1.0/P2) 
Specify the ratio between P1.0 and P2 where P1.0 is the group one proportion under the null hypothesis. 

This ratio is used with P2 to calculate the value of P1.0 using the formula: P1.0 = (Ratio) x (P2). 

The power calculations assume that P1.0 is the value of the P1 under the null hypothesis. In this non-null case, the 
value of P1.0 is not equal to P2 as it is in the null case. 

Ratios must be positive. R0 cannot take on the value of 1. 

You may enter a range of values such as 0.95 .97 .99 or .91 to .99 by .02.  

R1 (Ratio|H1 = P1.1/P2) 
Specify the ratio between P1.1 and P2. P1.1 is the proportion in group 1 under the alternative hypothesis. This 
ratio is used with P2 to calculate the value of P1.1 using the formula: P1.1 = R1 x P2. 

The power calculations assume that P1.1 is the actual value of the proportion in group 1 (experimental or 
treatment group). 

Ratios must be positive. You may enter a range of values such as 0.95 1 1.05 or 0.9 to 1.9 by 0.02.  

Effect Size – Group 2 (Reference) 

P2 (Group 2 Proportion) 
Specify the value of p2 , the control, baseline, or standard group’s proportion. The null hypothesis is that the two 
proportions differ by a specified amount (See Group 1 Proportion below).  

Since p2 is a proportion, these values must be between 0 and 1. 

You may enter a range of values such as 0.1 0.2 0.3 or 0.1 to 0.9 by 0.1. 

Effect Size – Intracluster Correlation 

ICC (Intracluster Correlation) 
Enter a value (or range of values) for the intracluster correlation. This correlation may be thought of as the simple 
correlation between any two observations in the same cluster. It may also be thought of as the proportion of total 
variance in the observations that can be attributed to difference between clusters.  

Although the actual range for this value is between 0 to 1, typical values range from 0.002 to 0.05. 
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Example 1 – Finding Power 
A study is being designed to study the effectiveness of a new treatment. Historically, the standard treatment has 
enjoyed a 60% cure rate. The new treatment is more expensive and has more side effects than the standard 
treatment. Thus, the new treatment will be adopted if the ratio of the new treatment to the old treatment is at least 
1.1333. 

The researchers will recruit patients from various hospitals. All patients at a particular hospital will receive the 
same treatment. They anticipate an average of 100 patients per hospital. Based on similar studies, they estimate 
the intracluster correlation to be 0.002. 

The researchers plan to use the Farrington and Manning likelihood score test statistic to analyze the data. They 
want to study the power of the one-sided Farrington and Manning test at group cluster sizes ranging from 2 to 10 
for detecting a ratio of 1.1333 when the actual cure rate ratio ranges from 1.1667 to 1.2667. The significance level 
will be 0.05. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home 
window, load the Non-Unity Null Tests for the Ratio of Two Proportions in a Cluster-Randomized Design 
procedure window by expanding Proportions, then Two Proportions (Cluster-Randomized), then clicking on 
Test (Non-Zero Null), and then clicking on Non-Unity Null Tests for the Ratio of Two Proportions in a 
Cluster-Randomized Design. You may then make the appropriate entries as listed below, or open Example 1 by 
going to the File menu and choosing Open Example Template. 

Option Value 
Design Tab 
Solve For ................................................ Power 
Alternative Hypothesis ............................ One-Sided (H1: P1/P2 > R0) 
Alpha ....................................................... 0.05 
K1 (Clusters in Group 1) ......................... 2 4 6 8 10 
M1 (Items per Cluster in Group 1) .......... 100 
K2 (Clusters in Group 2) ......................... K1 
M2 (Items per Cluster in Group 2) .......... M1 
R0 (Ratio|H0 = P1.0/P2) ......................... 1.1333 
R1 (Ratio|H1 = P1.1/P2) ......................... 1.1667 to 1.2667 by 0.02 
P2 (Group 2 Proportion) ......................... 0.6 
ICC (Intracluster Correlation) .................. 0.002 
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Output 
Click the Calculate button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results ──────────────────────────────────────────────────────────── 
Test Statistic:   Likelihood Score Test (Farrington & Manning) 
Hypotheses:   H0: P1/P2 ≤ R0   vs.   H1: P1/P2 > R0 
 
        Group 1   Group 2                           Intra-  
      Clusters/ Clusters/ Group 2 Group 1 Group 1   Cluster  
          Items     Items    Prop Prop|H0 Prop|H1 Ratio|H0 Ratio|H1 Corr.  
Power     K1/M1     K2/M2      P2    P1.0    P1.1 R0 R1 ICC Alpha 
0.09925 2/100 2/100 0.6000 0.6800 0.7000 1.133 1.167 0.0020 0.050 
0.12780 4/100 4/100 0.6000 0.6800 0.7000 1.133 1.167 0.0020 0.050 
0.15327 6/100 6/100 0.6000 0.6800 0.7000 1.133 1.167 0.0020 0.050 
0.17719 8/100 8/100 0.6000 0.6800 0.7000 1.133 1.167 0.0020 0.050 
0.20011 10/100 10/100 0.6000 0.6800 0.7000 1.133 1.167 0.0020 0.050 
0.14271 2/100 2/100 0.6000 0.6800 0.7120 1.133 1.187 0.0020 0.050 
0.20359 4/100 4/100 0.6000 0.6800 0.7120 1.133 1.187 0.0020 0.050 
0.25939 6/100 6/100 0.6000 0.6800 0.7120 1.133 1.187 0.0020 0.050 
0.31193 8/100 8/100 0.6000 0.6800 0.7120 1.133 1.187 0.0020 0.050 
0.36167 10/100 10/100 0.6000 0.6800 0.7120 1.133 1.187 0.0020 0.050 
0.19812 2/100 2/100 0.6000 0.6800 0.7240 1.133 1.207 0.0020 0.050 
0.30234 4/100 4/100 0.6000 0.6800 0.7240 1.133 1.207 0.0020 0.050 
0.39591 6/100 6/100 0.6000 0.6800 0.7240 1.133 1.207 0.0020 0.050 
0.48004 8/100 8/100 0.6000 0.6800 0.7240 1.133 1.207 0.0020 0.050 
0.55504 10/100 10/100 0.6000 0.6800 0.7240 1.133 1.207 0.0020 0.050 
0.26566 2/100 2/100 0.6000 0.6800 0.7360 1.133 1.227 0.0020 0.050 
0.41960 4/100 4/100 0.6000 0.6800 0.7360 1.133 1.227 0.0020 0.050 
0.54844 6/100 6/100 0.6000 0.6800 0.7360 1.133 1.227 0.0020 0.050 
0.65373 8/100 8/100 0.6000 0.6800 0.7360 1.133 1.227 0.0020 0.050 
0.73779 10/100 10/100 0.6000 0.6800 0.7360 1.133 1.227 0.0020 0.050 
0.34426 2/100 2/100 0.6000 0.6800 0.7480 1.133 1.247 0.0020 0.050 
0.54610 4/100 4/100 0.6000 0.6800 0.7480 1.133 1.247 0.0020 0.050 
0.69577 6/100 6/100 0.6000 0.6800 0.7480 1.133 1.247 0.0020 0.050 
0.80136 8/100 8/100 0.6000 0.6800 0.7480 1.133 1.247 0.0020 0.050 
0.87306 10/100 10/100 0.6000 0.6800 0.7480 1.133 1.247 0.0020 0.050 
0.43146 2/100 2/100 0.6000 0.6800 0.7600 1.133 1.267 0.0020 0.050 
0.66963 4/100 4/100 0.6000 0.6800 0.7600 1.133 1.267 0.0020 0.050 
0.81810 6/100 6/100 0.6000 0.6800 0.7600 1.133 1.267 0.0020 0.050 
0.90384 8/100 8/100 0.6000 0.6800 0.7600 1.133 1.267 0.0020 0.050 
0.95076 10/100 10/100 0.6000 0.6800 0.7600 1.133 1.267 0.0020 0.050 
 
Report Definitions 
H0 is an abbreviation for the null hypothesis. This is the hypothesis being evaluated by the statistical test. 
H1 is an abbreviation for the alternative hypothesis. This hypothesis gives the "true" parameter values. 
Power is the probability of rejecting a false null hypothesis. It should be close to one. 
K1 and K2 are the number of clusters in groups 1 and 2, respectively. 
M1 and M2 are the average number of items (subjects) per cluster in groups 1 and 2, respectively. 
P2 is the proportion for group 2, the standard, reference, baseline, or control group. 
P1.0 is the proportion for group 1 (the treatment group) assuming the null hypothesis (H0). 
P1.1 is the proportion for group 1 (the treatment group) assuming the alternative hypothesis (H1). 
R0 = P1.0/P2 is the ratio assuming the null hypothesis (H0). 
R1 = P1.1/P2 is the actual ratio at which the power is calculated. 
ICC is the intracluster correlation. 
Alpha is the probability of rejecting a true null hypothesis. 
 
Summary Statements ───────────────────────────────────────────────────────── 
Sample sizes of 200 in group 1 and 200 in group 2, which were obtained by sampling 2 clusters 
with 100 subjects each in group 1 and 2 clusters with 100 subjects each in group 2, achieve 
9.925% power to detect a ratio of 1.167 when the null-hypothesized ratio is 1.133. The 
proportion in group 1 (the treatment group) is assumed to be 0.6800 under the null hypothesis 
and 0.7000 under the alternative hypothesis. The proportion in group 2 (the control group) is 
0.6000. The test statistic used is the one-sided Likelihood Score Test (Farrington & Manning). 
The intracluster correlation is 0.0020, and the significance level of the test is 0.050. 
 

This report shows the values of each of the parameters, one scenario per row. The total number of items sampled 
in group 1 is N1 = K1 x M1. The total number of items sampled in group 2 is N2 = K2 x M2. 
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Plots Section 
 

  
 

     
 

The values from the table are displayed on the above charts. These charts give us a quick look at the sample sizes 
that will be required for various values of R1. 
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Example 2 – Finding the Sample Size (Number of Clusters) 
Continuing with the scenario given in Example 1, the researchers want to determine the number of clusters 
necessary for each value of R1 when the target power is set to 0.80. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home 
window, load the Non-Unity Null Tests for the Ratio of Two Proportions in a Cluster-Randomized Design 
procedure window by expanding Proportions, then Two Proportions (Cluster-Randomized), then clicking on 
Test (Non-Zero Null), and then clicking on Non-Unity Null Tests for the Ratio of Two Proportions in a 
Cluster-Randomized Design. You may then make the appropriate entries as listed below, or open Example 2 by 
going to the File menu and choosing Open Example Template. 

Option Value 
Design Tab 
Solve For ................................................ Sample Size (K1) 
Alternative Hypothesis ............................ One-Sided (H1: P1/P2 > R0) 
Power ...................................................... 0.80 
Alpha ....................................................... 0.05 
M1 (Items per Cluster in Group 1) .......... 100 
K2 (Clusters in Group 2) ......................... K1 
M2 (Items per Cluster in Group 2) .......... M1 
R0 (Ratio|H0 = P1.0/P2) ......................... 1.1333 
R1 (Ratio|H1 = P1.1/P2) ......................... 1.1667 to 1.2667 by 0.02 
P2 (Group 2 Proportion) ......................... 0.6 
ICC (Intracluster Correlation) .................. 0.002 

Output 
Click the Calculate button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results ──────────────────────────────────────────────────────────── 
Test Statistic:   Likelihood Score Test (Farrington & Manning) 
Hypotheses:   H0: P1/P2 ≤ R0   vs.   H1: P1/P2 > R0 
 
        Group 1   Group 2                           Intra-  
      Clusters/ Clusters/ Group 2 Group 1 Group 1   Cluster  
          Items     Items    Prop Prop|H0 Prop|H1 Ratio|H0 Ratio|H1 Corr.  
Power     K1/M1     K2/M2      P2    P1.0    P1.1 R0 R1 ICC Alpha 
0.80135 96/100 96/100 0.6000 0.6800 0.7000 1.133 1.167 0.0020 0.050 
0.80857 38/100 38/100 0.6000 0.6800 0.7120 1.133 1.187 0.0020 0.050 
0.80998 20/100 20/100 0.6000 0.6800 0.7240 1.133 1.207 0.0020 0.050 
0.80359 12/100 12/100 0.6000 0.6800 0.7360 1.133 1.227 0.0020 0.050 
0.80136 8/100 8/100 0.6000 0.6800 0.7480 1.133 1.247 0.0020 0.050 
0.81810 6/100 6/100 0.6000 0.6800 0.7600 1.133 1.267 0.0020 0.050 

 

The required sample size depends a great deal on the value of R1. The researchers should spend time determining 
the most appropriate value for R1.  
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Example 3 – Validation 
This procedure uses the same mechanics as the Tests for Two Proportions in a Cluster-Randomized Design 
procedure. We refer the user to Example 4 of Chapter 230 for the validation. 
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